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New Webroot users - Start here

If you are new to Webroot or have not used a Webroot plugin before please follow the step by step Installation
instructions for new Webroot users below. This manual assumes you have already purchased Webroot and
have signed into the Webroot console. If you have not purchased Webroot, please contact your ConnectWise
representative.

When upgrading from plugin version 2.5 - Start here

Please allow yourself enough time for the upgrade and actions afterwards. Read and follow the step by step
Upgrade instructions below.

Help & ?

Please make use of the Help tab located on the bottom left of the plugin and the video tutorials @ found within
the Client, Computers and Locations tabs throughout the plugin.

@ Webroot SecureAnywhere with Unity /
WEBROOT Clients @
Video Help Links
@webroot.com )
Setup Clients
Overview Setup Automation
Clients Setup Webroot Groups
Computers Client | Webroot Site | Webr
. ¥ Webroot Webroot Activi
Locations
LabTech Test Client  LabTech Test Site  Actiwv
Taner & Co Site Overridden  Actiw
Test Test Site  Activi
Globkal Transport Inc
GSM Portal
Settings
/ Last data update: 12/10/2018 15:07:32 UTC
Help
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Installation instructions for new Webroot users

Step 1 — Obtaining the plugin

If you are new to Webroot the latest Webroot plugin can be installed from CW Solution Center. Please select
Security and Webroot and follow the standard Solution Center installation instructions.

3y Status: IN - Active Timeslips  Links | Tools
I Import ¥
b Reperting >

I Change Password
Options
User Class Manager
Refresh Mavigation Tree
Reload System Cache
Show ID's

Change Systermn Password

Quick Connect

Solution Center
Language Pack Editor
Managed Service Catalog
Standards & Health
Intel® vPro™ Manager

Control Support Sessions Viewer
™

8. Solution Center - lanthom.hostedrmm.com - Admin - o »

Solution Center ‘

% 1 Solution in Queue

My System
My System Solutions

©) Out of Sync Solutions
0 System Backups

o ey v
() Reload Solution Center Client

Solutions
All Solutions

0 Backup
B Desktop Management
® End of Life

@® ignite
% Network Devices '
“ other V
# PSA Integration
A1 Reports - WEBROOT
8 securi
Mre Solutons.

Search

Webroot

Note: Please navigate to the Plugin Manager within the Control Center and Enable “Webroot SecureAnywhere
with Unity” and “Webroot SecureAnywhere with Unity RA” and restart your Control Center, before proceeding to

next step.

Webroot SecureAnywhere with Unity

Enable

% Disable

2 Refresh

g‘ﬁ About

ebroot SecureAnywhere with Unity RA | 3.0.1622.8 | Webroot Inc. | Webroot SecureAnywhere with Unity RA ‘WebrootRA.dIl

Best Practice: After installation, we recommend re-loading the Reload DBAgent Plugins, Update Remote
Agent Plugins & Reload Control Center Plugins in the order shown below.

2 Refresh |3 Advanced -

Reload Plugins +

Disable Plugins 3
Manage Plugins  »

3 Reload Control Center Plugins

2Update Remote Agent Plugins
1Reload DBAgent Plugins
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Step 2 — Plugin settings

After you have restarted the Automate Control Center, click on Webroot SecureAnywhere with Unity to open
the plugin dashboard and select Settings.

ConnectWise Automate V11.x

f‘._: Refresh @ Dashboard .l, Monitors %Alerts&lnfu @ Tickets &g Search ‘ Patch Manager || -:{1. Standards & Heafth §y m@wwrmt SecureAnywhere with Unity (\@Int

ConnectWise Automate V12.x
8 Webraot - hitps ostedrmm.com

Intel® vPro™
Manager

Report Center
Standards & Health
Webroot

secureAnywhere
with Unity

@D e f - O
WEBROOT Settings
API Authentication Webroot Agent
Overview Parent Keycode [ Use the unique identifier option during installation
Clients
Username
Computers Alerts and Pop-ups
Locations Password ] Enable additional alerts when computers are in an "Attention Required" state

Client ID ] Enable reboot pop-ups when computers are in an "Attention Required” state
Client Secret ] Enable additional alerts when computers stay infected for longerthan |12 ¥ | hours

(] Enable alerts when endpoint is stale for longer than | 30 v days

[C] Enable expired license alerts

GSM Portal
Save

Settings

Help

Click on GSM Portal to access the Webroot Console and enter your authentication information to access the
GSM.

GSM Portal
Settings

Help
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WEBROOT

BEST PRACTICE: We strongly recommend you create a NEW USER with ADMIN rights across ALL existing
Webroot Sites in the GSM and use the NEW USER Account for Webroot Unity Access for CW Automate. This
will then avoid data discrepancies if Unity users do not have Admin rights across some Webroot Sites. Once
complete follow instructions below.

Navigate to Settings > Account Information in the GSM and copy and paste the Parent Keycode from the
GSM to the Parent Keycode in the plugin. Please ensure no spaces are entered at the end.

0 Webroot Securefnywhere with Unity

SecureAnywhere

Dashboard Sites Admins Groups Policies Overrides Alerts Reports

WEBROOT Settings

API Authentication

Overview Parent Keycode | Subscriptions  Account Information  Data Filter APl Ac
Clients
Username
Account Details
Computers
. Password .
Locations Site / Company Name N M
Client 1D Company Address
Client Secret Contact Email n @webroot.com
Contact Phone 4
Parent Keycode S :-‘«h 00 devices |
Download Usage Report dd/mm/yyyy Download

Use either the New User credentials you created in step 2 of the Plugin Settings or use your existing GSM
Username and Password in the Authentication Settings for the ConnectWise Automate Plugin.

0 Webroot SecureAnywhere with Unity

WEBROOT Settings

API| Authentication

Overview Parent Keycode

Clients
Username

Computers
Password

Locations

Client ID

Client Secret

Page 7 | © 2019 Webroot Inc. All rights reserved. | Proprietary and Confidential Information May 29, 2019



WEBROOT Integration for ConnectWise Automate User Guide

Navigate to Settings > API Access Tab and click New to create new API credentials.
WEBROOT

SecureAnywhere

Dashboard Sites Admins Groups Policies Qverrides Aleris Reports

Subscriptions  Account Information  Data Filker APl Access

[ @ New | [# Edit Delete Renew Secret Suspend / Resume [1J API Documentation ([ developer.webroot.com
Client Credentials
Name Description Client ID

Enter a Uniqgue Name and Description and Click Create

Create New Client Credential >

Name @
CW Automate Plugin
Description ®@

Mew Unity APl Master Credentials for v3.x Plugin

Copy and paste Client Id and Client Secret to the CW Automate Plugin

@ Webroot Securefinywhere with Unity Client Credential Record X

WEBROOT Settings Important! This is the client identifier and the client secret for the client credential record listed below. The client secret is nt
. . /\ persisted and it is your respensibility to remember the client secret and treat it as sensitive information. If you lose the client
AP Authentication secret you need to generate a new secret in order to continue using the affected client identifier in your application.

Qverview Parent Keycode
Name
Clients
Username CW Automate Plugin
Computers
Password Description
Locations
Client ID New Unity AP1 Master Credentials for v3.x Plugin
- Client ID
Client Secret e
client_ ¥@webroot.com
Authenticate
Client Secret
Xj =

/\ Please make note of your client secret

I have made note of the client secret
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Once all credentials are entered, click on Authenticate.

@ Webroot SecureAnywhere with Unity - a x
WEBROOT Settings

API Authentication Webroot Agent
Overview Parent Keycode | S A (] Use the unique identifier option during installation
Clients

Username 3 @webroot.com
Computers Alerts and Pop-ups
Locations Password sesssesses (] Enable additional alerts when computers are in an "Attention Required” state

Client ID client_ @webroot.com [T Enable reboot pop-ups when computers are in an "Attention Required” state

- (] Enable additional alerts when computers stay infected for longerthan | 12~ hours
Client Secret EET TR TR TS
(] Enable alerts when endpoint is stale forlongerthan |30~ | days
Authenticate
Enable expired license alerts

GSM Portal - P
Settings Save
Help

When the credentials are successfully authenticated, Good Connection and authenticated username will be
displayed.

@ Webroot SecureAnywhere with Unity — [m] x

WEBROOT Settings

@webroot.com API Authentication Webroot Agent
Overview Good Connection Logout [] Use the unique identifier option during installation
Clients.
Computers Alerts and Pop-ups
Locations [_] Enable additional alerts when computers are in an "Attention Required” state

[T Enable reboot pop-ups when computers are in an "Attention Required” state
[ Enable additional alerts when computers stay infected for longer than | 12~ | hours
[T Enable alerts when endpoint is stale for longerthan 30 v | days

Enable expired license alerts
GSM Portal o P

Settings Save

Help

If required, please set the desired settings and click Save. We recommend these settings are left at their default
values at this stage. When you are more familiar with the plugin and have had a chance to go through the
Plugin Walkthrough, you can set these at any time.

@ Webroot SecureAnywhere with Unity - O X

WEBROOT  Settings

@webroot.com API Authentication Webroot Agent
Overview Good Connection Logout ] Use the unique identifier option during installation
Clients
Computers Alerts and Pop-ups
Locations ("] Enable additional alerts when computers are in an "Attention Required” state

[_] Enable reboot pop-ups when computers are in an "Attention Required” state
] Enable additional alerts when computers stay infected for longerthan | 12~ | hours
(] Enable alerts when endpoint is stale for longer than |30 v days

[C] Enable expired license alerts

GSM Portal

. Save
Settings /

Help
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Step 3 — Assigning Clients to existing Webroot Sites

If you have already created Sites in the Webroot Global Site Manager that match your Clients and there is a 1 to
1 relationship between CW Automate Clients & Webroot Sites, you must Assign Webroot Sites to Clients
within the plugin. This will establish an APl connection into the GSM for each Site, pulling in correct data and
enabling advanced functionality. Please take your time when assigning Clients to Sites, ensure the correct
Clients are assigned to correct Sites.

If you have not yet created Webroot Sites, please go to the next step.

Click on Clients tab

Right click on a specific Client

Select Webroot site

Select Assigh Webroot site

Use the drop down menu to assign the correct site (ensure keycode matches the imported key from previous
version)

(@ Webroot SecureAnywhere with Unity - O X
WEBROOT Clients ShowAll v | Configure v Refresh
@webroot.com
Overview [sear
Clients Drag a column header here to group by that column
Computers |Client ‘ Webroot Site |Webrout Site Status | Auto Deploy | Workstation Group | Server Group |Aubomate Scans | Site Keycode -
3 Global Tr ri | A
Locations e el
[
KO Test KO TestSite  Active Enable febrootisits i
Webroot Group 3
LabTech Test Client  LabTech Test Site  Active Enable Auto Deploy ¥ 2
Webroot Webroot Active Disablg Automate Scans * |t Group Enabled c D
Open Client
Taner & Co Site Overridden  Active Enables Enabled £ 2
GSM Portal
Settings
Last data update: 20/07/2018 15:24:37 UTC
Help

Assign Webroot Site New Site
o B
ACME Sclicitors / 3 D

Corsair Inc [ F 7

Global Transport Inc / AN———> |

0
Test Site / & E
Webroot / C b]
Widgets LLC /1 T
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Step 4 — Creating new Webroot sites

If you are a new Webroot user and have not created any matching Sites for your Clients, then you should create
New Webroot Sites either directly within the plugin or within the Global Site Manager (GSM).

If you do NOT have a Global Site Manager but only have a Webroot Business Console, please contact your
Webroot representative or Webroot support.

To create Sites directly within the plugin for each of your Clients, follow the instructions below:

Click on Clients tab

Right click on a specific Client

Select Webroot site

Select Assigh Webroot site

Select New

Fill in the required fields and click Create

@ Webroot SecureAnywhere with Unity - [u] *
WEBROOT Clients ShowAll v | Configure v Refresh
@webroot.com
[
Overview
Clients Drag a column header here to group by that column
Computers | Client | Webroot Site | Webroot Site Status | Auto Deploy | Workstation Group | Server Group | Automate Scans | Site Keycode: -
Locations ' . - =
KO Test KO Test Site  Active Enahla[ Mebivot. St » || Assign Webroot Site b8 [
Webiroot Group * _r_' Associate this client with a Webroot site.
LabTech Test Client  LabTech Test Site  Active Enable Auto Deploy » Up-
Webroot ‘Webroot Active Disabl¢ Automate Scans * kGroup Enabled C ]
Open Client
Taner & Co Site Overridden  Active E Enabled S 2
GSM Portal
Settings
Last data update: 20/07/2018 15:24:37 UTC
Help
Assign Webroot Site J Mew Site Create Webroot Site
Site Name
K -
Global Transport Inc
Manual Site Keycode Keycode Type
(@ Full ) 30 day trial
Save Cancel Seats *Required
Billing Cycle
Annually
Billing Date

Jan v |1 v
Comments

Created by CW Automate

(] Include Global Policies
] Include Global Overrides
Default Policy
High Security Policy v

Report Email Distribution List  *Required

Create Cancel
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Step 5 — Activating Auto Deploy

To allow the plugin to install Webroot agents, Auto Deploy setting must be enabled at the CW Automate
Location level. The default auto deploy setting at Location level is Auto Deploy = Disabled. When set to
Enabled webroot agents will start to deploy to all Computers under that Location, unless specific Computers
have their Auto Deploy setting set to Disabled.

To enable Auto Deploy at Location Level, click on Locations
Right click on the relevant Location OR select multiple locations and use the Configure drop down menu

Select Auto Deploy
Select Enable to Auto Deploy

@) Webroot SecureAnywhere with Unity - O X
WEBROOT Locations Configure Refresh
@webroot.com
[ |
Overview
Clients FEEnEE
Computers | Client - | Location Auto Deploy
. »

Locations

K | Auto Deploy 3 Disable

Open Location | Enable
LabTecth resremer VIrTETTECTITTEE ERd DIEd
| Enables auto deployment.

Taner & Co London Disabled

Taner & Co Remate Disabled

Webroot Main Disabled

Webroot Mew Computers  Disabled
GSM Portal
Settings

Last data update: 20/07/2018 17:03:24 UTC

Help

Note: By default, auto deploy is set to:
e Enabled at Client/Site level
e Disabled at Location level
e Enabled at Computer level

Step 6 — Plugin walkthrough

Walk through the rest of the manual and enjoy the powerful new features available in the version 3.x plugin.
Jump to the Plugin Walkthrough section and go through the rest of the manual.
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Upgrade instructions

Step 1 - Upgrading from plugin version 2.5

Important; When upgrading from any previous version of the Webroot plugin to Version 3.x you MUST first
upgrade your existing plugin to version 2.5.13 before attempting to upgrade to Version 3.x. Version 2.5.13 can
be downloaded from the link below:

Version 2.5.x http://download.webroot.com/RMM/LabTech/Webroot-Deploy-Solution v2-5.zip

Step 2 — Obtaining the plugin

If you are upgrading from a previous version the latest of the Webroot plugin can be installed from CW Solution
Center. Please select Security and Webroot and follow the standard Solution Center installation instructions.

3y Status: IN - Active Timeslips  Links | Tools

& Solution Center - lanthom.hostedrmm.com - Admin =" %

Import > : i
| e L Solution Center -
h Reporting H 4 1 Solution in Queue
My System
I Change Password 1)

My System Solutions
Options
€ Out of Sync Solutions
User Class Manager i
© System Backups ' '
Refresh Navigation Tree yrtallation ity
@) Reload Solution Center Client
Reload System Cache
Solutions
Show ID's All Solutions.

Change Systemn Password O Backup
B Desktop Management

® End of Life
Quick Connect ® ignite

& Network Devices
Solution Center » ' E
Language Pack Editor WEBROOT
Managed Service Catalog
More Solutions...

Standards & Health

Webroot

Search

Intel® vPro™ Manager

Control Support Sessions Viewer
™

IMPORTANT NOTE: After an Upgrade Webroot SecureAnywhere with Unity RA WebrootRA.dlIl is added to the
CW Automate plugin manager. Please navigate to Help > Plugin Manager within the Control Center and
Enable “Webroot SecureAnywhere with Unity RA” and restart your Control Center, before proceeding to next
step.

vy Wehmnt SecureAnvwhere with Unity 3.0.1622.8 t ywhere with Unity webmnt.dll

Webroot SecureAnywhere with Unity RA | 3.0.1622.8 | Webroot Inc. | Webroot SecureAnywhere with Unity RA ---_ WebrootRAdII

Enable

Mg Disable

2 Refresh

i About

Best Practice: After the upgrade process above, we recommend re-loading the Reload DBAgent Plugins,
Update Remote Agent Plugins & Reload Control Center Plugins in the order shown below.

: Refresh | & Advanced ~

Reload Plugins + 3Reload Control Center Plugins

Disable Plugins  » 2Update Remote Agent Plugins

Manage Plugins  » 1Reload DBAgent Plugins
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Step 3 -

What happens after an upgrade from plugin version 2.5

After an upgrade from plugin version 2.5.13 of the Webroot ConnectWise Automate (CWA) plugin you should
expect the following:

1- Settings below are automatically transferred across

a.
b.
c.
d.

The Unique Identifier Setting
Alerts and pop-up settings
Auto-deploy and exceptions settings

Site keycodes without assignment

Note: Automate Clients will require to be assigned to Webroot Sites for full Unity API functionality

2- The plugin core functionality such as auto-deployment of Webroot agents will operate but some portions will
not show data and will be replaced by N/A and non-GSM until Automate Clients are assigned to Webroot

Sites
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Step 4 — Plugin settings

After you have restarted the Automate Control Center, click on Webroot SecureAnywhere with Unity to open
the plugin dashboard and select Settings.

ConnectWise Automate V11.x

ﬁ?_’; Refresh 5 Dashboard .l, Monitors %Alerts& Info @ Tickets &g Search ' Patch Manager ||-£1 Standards & Heafth @m@wwmot SecureAnywhere with Unity intel) Int

ConnectWise Automate V12.x

Manager

Report Center

Standards & Health

WEBROOT Settings
API Authentication Webroot Agent
Overview Parent Keycode |_J Use the unique identifier option during installation
Clients
Username
Computers Alerts and Pop-ups
Locations Password ("] Enable additional alerts when computers are in an "Attention Required" state
Client ID ___| Enable reboot pop-ups when computers are in an "Attention Required™ state
Client Secret (] Enable additional alerts when computers stay infected for longer than 12 v | hours
(] Enable alerts when endpoint is stale for longerthan 30 v | days

(C] Enable expired license alerts

GSM Portal
Save

Settings

Help

Click on GSM Portal to access the Webroot Console and enter your authentication information to access the
GSM.

GSM Portal
Settings

Help
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BEST PRACTICE: We strongly recommend you create a NEW USER with ADMIN rights across ALL existing
Webroot Sites in the GSM and use the NEW USER Account for Webroot Unity Access for CW Automate. This
will then avoid data discrepancies if Unity users do not have Admin rights across some Webroot Sites. Once
complete follow instructions below.

Navigate to Settings > Account Information and copy and paste the Parent Keycode from the GSM to the
Parent Keycode in the plugin. Please ensure no spaces are entered at the end.

o Webroot SecureAnywhere with Unity

SecureAnywhere

Dashboard Sites Admins Groups Policies Overrides Alerts Reports l Settings |

WEBROOT  Settings
API Authentication

Overview lParer't Keycode I Subscriptions  Account Information  Data Filter APl Access
Clients
Username .
Account Details
Computers
. Password
Locations Site / Company Name N M
Client ID
Company Address
Client Secret Contact Email n @webroot.com
Contact Phone 4
Parent Keycode & Akmn devices |

Download Usage Report m

Use either the New User credentials you created in step 2 of the Plugin Settings or use your existing GSM
Username and Password in the Authentication Settings for the CW Automate Plugin.

@ Webroot SecureAnywhere with Unity

WEBROOT Settings

API Authentication

Overview Parent Keycode
Clients

Username
Computers

Password
Locations

Client ID

Client Secret
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Navigate to Settings > API Access Tab and click New to create new API credentials.
WEBROOT

SecureAnywhere

Dashboard Sites Admins Groups Policies Overrides Alerts Reports

Subscriptions  Account Information Data Filter APl Access

[ Edit <) Delete Renew Secret Suspend / Resume [ APl Documentation | /) developer.webroot.com
Client Credentials
Name Description Client ID

Enter a Uniqgue Name and Description and Click Create

Create New Client Credential X

Name @

CW Automate Plugin

Description @

New Unity APl Master Credentials for v3.x Plugin

Lo JE

Copy and paste Client Id and Client Secret to the CW Automate Plugin

0 Webroot Securefnywhere with Unity Client Credential Record
WEBRUUT Senlngs mmms|smec|mummuammummmmcrmwmwrmmmm The client secret is not
P oy and it is your he client secret and treat it as sensitive information. If you lose the client
API Authentication secret you need 1o generate a new secret in order 1o continue using the affected cient identifier in your application.
Overview Parent Keycode
Name
Clients
Username CW Automate Plugin
Computers
. Password Descripti
Locations fpten
Client 1D New Unity AP1 Master Creentials for v3.x Plugin
Client Secret Client 10
client_ ¥@webroot.com
Authenticate
Client Secret
X

A Please make note of your client secret

I have made note of the client secret
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Once all credentials are entered, click on Authenticate.

@ Webroot SecureAnywhere with Unity - o X
WEBROOT Settings
API Authentication Webroot Agent
Overview Parent Keycode | S BA (7] Use the unique identifier option during installation
Cleis Usemame . @webroot.com
Computers Alerts and Pop-ups
Looations Password | ctabt it ("] Enable ional alerts when comp arein an Required™ state
Client ID client_ @webrootcom (C) Enable reboot pop-ups when computers are in an "Attention Required” state
Client Secret S etsesiecseesse [C] Enable additional alerts when computers stay infected for longerthan 12~ hours
() Enable alerts when endpoint is stale for longerthan 30 v days
GSM Portal [T Enable expired license alerts
Settings Save
Help

When the credentials are successfully authenticated, Good Connection and authenticated username will be
displayed.

@ Webroot SecureAnywhere with Unity - a X

WEBROOT Settings

@webrootcom AP Authentication Webroot Agent
Overview Cood Gt Logout (7] Use the unique identifier option during installation
Clients
Computers Alerts and Pop-ups
Locations [ Enable { alerts when P are in an Required” state

(C) Enable reboot pop-ups when computers are in an "Attention Required” state
[C] Enable additional alerts when computers stay infected for longerthan 12~ hours
(] Enable alerts when endpoint is stale for longerthan 30 v days

GSM Portal [C] Enabie expired license alerts

Settings Save

Help

If required, please set the desired settings and click Save.

@ Webroot SecureAnywhere with Unity - o X

WEBROOT  Settings

@webroot.com API Authentication Webroot Agent
Overview Good Connection Logout [T Use the unique identifier option during installation
Clients
Computers Alerts and Pop-ups
Locations (C] Enable additional alerts when computers are in an "Attention Required" state

(] Enable reboot pop-ups when computers are in an "Attention Required” state
() Enable additional alerts when computers stay infected for longerthan 12 ¥ | hours
(] Enable alerts when endpoint is stale for longerthan 30 v days

(] Enable expired license alerts
GSM Portal

P Save
Settings /
Help
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Step 5 — Assigning Clients to existing Webroot Sites

If you have already created Sites in the Webroot Global Site Manager that match your Clients and there is a 1 to
1 relationship between CW Automate Clients & Webroot Sites, you must Assign Webroot Sites to Clients
within the plugin. This will establish an APl connection into GSM for each Site, pulling in correct data and
enabling advanced functionality. Please take your time when assigning Clients to Sites, ensure the correct
Clients are assigned to correct Sites.

Click on Clients tab

Right click on a specific Client

Select Webroot site

Select Assigh Webroot site

Use the drop down menu to assign the correct site (ensure keycode matches the imported key from previous
version)

@ Webroot SecureAnywhere with Unity - o *
WEBROOT Clients ShowAll v | Configure v Refresh
@webroot.com
[ce
Overview
Clients Drag a column header here to group by that column
Computers | Client | Webroot Site | Webroot Site Status | Auto Deploy | Workstation Group | Server Group | Automate Scans | Site Keycode -
- » Enabled

Locations - s -

KO Test K Test Site  Active Enable] Sebootsig »| | Assign Webroot Site 28 6

) ) ) | JebcoctGroup ' Associate this client with a Webroot site.
LabTech Test Client  LabTech Test Site Active Enablet Auto Deploy » w -
Webroot Webroot Active Disable Automate Scans * kt Group Enabled C ]
| Open Client

Taner & Co Site Overidden  Active Enablew Enabled S 12
GSM Portal
Settings

1 Last data update: 20/07/2018 15:24:37 UTC

Help

Assign Webroot Site New Site

[/ =
ACME Solicitors / 3 D
Corsair Inc / Fl 7
Global Transport Inc / AN———5
Kopmellt Site / 3 6
Lab Test Site / 3

ile Test Site / EJ 0
Test Site / & E
Webroot / C D
Widgets LLC / 1 7

rel

18]
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Step 6 — Creating new Webroot sites

If you are currently mapping Webroot Groups to Automate Clients then you must create New Webroot Sites
either directly within the plugin or within the Global Site Manager (GSM) and move the endpoints to the new
Webroot Sites via Change Keycode command in the Webroot console.

If you do NOT have a Global Site Manager but only have a Webroot Business Console, please contact your
Webroot representative or support.

To create Sites directly within the plugin, follow the instructions below:

Click on Clients tab

Right click on a specific Client

Select Webroot site

Select Assigh Webroot site

Select New

Fill in required fields and click Create

(D Webroot SecureAnywhere with Unity - o x
WEBROOT Clients ShowAll v Configure ~  Refresh
@webroot.com
Overview
Clients
Computers Chient Webroot Site Webroot Site Status | Auto Deploy | Workstation Group | Server Group | Automate Scans | Site Keycode -
Vocatione [} Global Transport Inc  N/A N/A Enabled WA N/A Enabled N/A
K Test Ko TestSite Active Erable | Weroot Ste || {Assign Webrool She 28 6
) ) FRSMOOL Qo "1 [ Associate this ciient with a Webroot site. |
LabTech Test Client  LabTech Test Site  Active Enable Auto Deploy » SR - 2
Webroot Webroot Active Disabl¢ Automate Scans * | Group Enabled C /]
Open Client
Taner & Co Site Overndden  Active Enabl w Enabled o 2
GSM Portal
Settings
Last data update: 20/07/2018 15:24:37 UTC
Help

Assign Webroot Site d New Site Create Webroot Site

[/ -le Site Name

Manual Site Keycode Global Transport Inc
Save Cancel Keycode Type

® Full O 30 day trial
Seats *Required

Billing Cycle
Annually
Billing Date
Jan v 1 ¢
Comments
Created by CW Automate
[ Include Global Policies
[ Include Global Overrides
Default Policy
High Security Policy v

Report Email Distribution List “Required

Create Cancel
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Step 7 — Activating auto deploy

To allow the plugin to install Webroot agents, Auto Deploy setting must be enabled at the CW Automate
Location level. The default auto deploy setting at Location level is Auto Deploy = Disabled. When set to
Enabled webroot agents will start to deploy to all Computers under that Location, unless specific Computers
have their Auto Deploy setting set to Disabled.

To enable Auto Deploy at Location Level, click on Locations tab
Right click on the relevant Location OR select multiple locations and use the Configure drop down menu

Select Auto Deploy

Select Enable to Auto Deploy

@ webroot SecureAnywhere with Unity - m} x
WEBROOT Locations Configure ~ Refresh
@webroot.com
Overview
Clients e
Computers | Client 4 | Location | Auto Deploy
l Global Transport Inc  Office Disabled
Locations o
K | Auto Deploy » Disable
| Open Location | Enable
LabTech resremenme—vwrroarweacrmes~tnaciea -
[ Enables auto deployment. ‘
Taner & Co London Disabled
Taner & Co Remote Disabled
Webroot Main Disabled
Webroot New Computers Disabled
GSM Portal
Settings
Last data update: 20/07/2018 17:03:24 UTC
Help
Note: By default, auto deploy is set to:

Enabled at Client/Site level
Disabled at Location level
Enabled at Computer level

Step 8 — Plugin walkthrough

Walk through the rest of the manual and enjoy the powerful new features available in the version 3.x plugin.
Jump to the Plugin Walkthrough section and go through the rest of the manual.
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Plugin Walkthrough

Webroot plugin version 3.x is our most advanced plugin to date and makes use of the Webroot Unity API,
unleashing more features then previously possible. But we have not just taken the old plugin and added new
features, instead we have completely rethought the user experience and built a plugin that is designed to be far
more efficient to use on a daily basis. The plugin walkthrough will take you through the features available.

Note: This plugin is compatible with CW Automate v10.5 and above.

Note: This plugin includes a separate Remote Agent plugin dll and should be noted when adding the plugin via
the Plugin Manager.

Dashboard

The dashboard contains everything needed to configure and use the plugin including all options for clients,
computers, locations, plugin settings and help links. The client, computer and location pages all contain right
click options which are also available in the upper right as Configure and Action options. There are also various
filters in the upper right-hand corner to help quickly view only the data desired.

Overview tab

The Overview tab displays a summary of the overall installation. The user, for example can easily identify if a
Client is without Webroot protection and can navigate to the necessary tab for quick configuration, with just a
single click. If certain infections have been active for longer than 24 hours, the user is alerted visually with the
Attention Required indicator; a single click will navigate the user to the infected computer for further action.
Quick navigation is possible from any of the numbers displayed within the “Clients” and “Computers in Webroot
Clients” tiles.

(@ Webroot SecureAnywhere with Unity - O X
WEBROOT Overview Al clients +  Refresh
@webroot.com n o
Clients Computers In Webroot Clients

Overview

Clients 1 1

Coeliurs Attention Required Infected Attention Required Infected

Locations l / 5 7 / 9
Webroot Total Webroot Total

Threats detected (last 7 days) Webroot Agent Distribution

' Threats Per Day I 002031 (4)

901943 (2)
I 00,1834 (1)
6
3
0

16/07/2018 00:00:00 UTC 20/07/2018 00:00:00 UTC
14/07/2018 00:00:00 UTC 18/07/2018 00:00:00 UTC

GSM Portal

Settings

Last data update: 20/07/2018 17:28:03 UTC
Help

Clients

¢ Infected — This displays the count of clients that contain a computer in the "Infected" state. When the
Webroot agent detects a threat, it will block the threat. Most threats, such as real-time or inactive threats are
removed in under 1 minute. Some threats require a clean scan before the endpoint is declared malware
free. Sometimes, threats are too deeply embedded in the system to be removed immediately without
causing system instability and Webroot agent may require a reboot to fully remove the infection. After the
usual daily scan and reboot, most infections are automatically and safely removed without any intervention.
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e Attention Required — Displays the count of clients that contain a computer in the "Attention Required" state.
To keep the malware reporting noise down to a minimum, we have created a new “Attention Required” flag
specifically designed for MSP environments. This flag is raised if an endpoint remains infected after 2
contiguous 12-hour checks. If the endpoint is rebooted or performs a scan at the point during any of the
checks, the counter will be reset for another 12 hours. In practice, the “Attention Required” flag will be true
(2) if the endpoint remains infected after about 36 hours (without being rebooted or shut down). This
ensures the endpoint has gone through at least 1 reboot/scan cycle before raising the “Attention Required”
flag. You can choose to take either manual or automatic action if you wish, such as initiating another scan
or to inform the end user to reboot. Some actions such as running a reboot request for the user may be
automated. See Settings Section.

Important Note: The “Attention Required” flag is distinctly different than the “Needs Attention” state in the
Webroot Console, which is set as soon as an infection is detected. Each indicator works independently.

e Webroot — This displays the count of clients that are assigned to a Webroot site (has a Webroot site key).

e Total — This displays the total count of Automate clients.

Computers in Webroot Clients

¢ Attention Required — This displays the count of computers in the "Attention Required"” state. See “Attention
Required” in Clients above for full explanation.

¢ Infected — This displays the count of computers in the "Infected" state. See “Infected” in Clients above for
full explanation.

e Webroot — This displays the count of computers with Webroot installed that are contained in a CWA client
assigned to a Webroot site.

e Total — This displays the total count of computers that are contained in a CWA client assigned to a Webroot
site.

Note: Only computers that have a Webroot Site key assigned via the Clients tab will be added to the total.

Threats Detected (last 7 days)

This will display a bar chart with a count of threats detected over the last seven days.

Webroot Agent Distribution

This will display a pie chart with different Webroot software version being identified.

Page 23 | © 2019 Webroot Inc. All rights reserved. | Proprietary and Confidential Information May 29, 2019



WEBROOT Integration for ConnectWise Automate User Guide

Clients tab

The Clients tab lists all clients available in ConnectWise Automate and allows easy configuration of Webroot
sites. The following options are available within the Clients tab:

e Assigning/Removing a Webroot site
o Assigning an Existing site to a Client
o Creating a new site and assigning to a Client
o Using a non-GSM manually entered site key (for temporary use only)
o Removing a site
e Auto-Installation of new endpoints to
o Workstation Group
o Server Group
o Auto-Deploy Enable/Disable at Client Level

e ConnectWise Automate initiated Scans Enable/Disable

Webroot Site

(@ Webroot SecureAnywhere with Unity - m] X
WEBROOT Clients ShowAll v | Configure v Refresh
@webroot.com
Overview | =
Clients Drag a column header here to group by that column
Computers ‘Client |Webroot Site |Webram Site Status | Auto Deploy | ‘Workstation Group | Server Group ‘Aubomale Scans ‘ Site Keycode -
. [l Global Transport Inc N/A e —_—
SOCatRS Webroot Site »
. Test Test Site  Active Webroot Group » up Default Group Enabled 3 (]
LabTech Test Client  LabTech Test Site Active ST ERE) *lup Default Group Enabled 3 2
Automate Scans [
Webroot Webroot Active Open Client P Default Group Enabled C D
Taner & Co Site Overridden  Active Enabled N/A M/A Enabled S 2
GSM Portal
Settings
I Last data update: 27/07/2018 13:26:40 UTC
Help
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Webroot site > Assign an Existing Webroot Site to a Client

If you have already created Sites in the Webroot Global Site Manager (GSM) that match your Automate
Clients and there is a 1 to 1 relationship between CW Automate Clients & Webroot Sites, you can Assign
Webroot Sites to Clients within the plugin. This process is deliberately manual to ensure absolute accuracy.
When all Clients are Assigned to Sites, an API connection to the GSM will be established, pulling in correct
data and enabling advanced functionality. Please take your time when assigning Clients to Sites, ensure the
correct Clients are assigned to correct Sites.

Click on Clients tab

Right click on a specific Client

Select Webroot site

Select Assigh Webroot site

Use the drop down menu to assign the correct site (ensure keycode matches the imported key from previous
version)

Webroct SecureAnywhere with Uni - [u] b4
yw ity
WEBROOT Clients ShowAll v Configure v Refresh
@webroot.com
[
Overview
clients \"-] a coumn header here (0 group oy that column
Computers | Client | Webroot Site | Webroot Site Status | Auto Deploy | Workstation Group | Server Group | Automate Scans | Site Keycode -
Locations ! . = - — =
KO Test KNI Test Site  Active Enable-[ JRNeOa SR d Assig Webroot Site b8 6
Webroot Group L -r—l Associate this client with a Webroot site.
LabTech Test Client  LabTech Test Site  Active Enable; Auto Deploy ¥ rolp- -
Webroot Webroot Active Disable Automate Scans * |t Group Enabled C D
Open Client
Taner & Co Site Qverridden  Active Enabl Enabled 5 2
GSM Portal
Settings
Last data update: 20/07/2018 15:24:37 UTC
Help
Assign Webroot Site New Site
f
/ L
ACME Solicitors / 3 D
Corsair Inc / F 7
Global Transport Inc / AN———— el
Ky t Site / 3 6
Lab Test Site / 3 2
ile Test Site / E 0
Test Site / & E
Webroot / C D
Widgets LLC / 1 7
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Webroot Site > Creating a New Webroot Site and assigning it to a Client

To create Sites directly within the plugin:

Click on Clients tab

Right click on a specific Client
Select Webroot site
Select Assigh Webroot site

Select New

Fill in required fields and click Create

This process ensures the correct Clint name is pulled in automatically from CW Automate reducing errors

@ Webroot SecureAnywhese with Unity - o ®
WEBROOT Clients ShowAll +  Configure ~  Refresh
@webroot.com
Overview
Clients Drag & co ere b
Computers | Webroot Site | Webroot Site Status | Auto Deploy | Workstation Group | Server Group | Automate Scans | Site Keycode
Locations = :
K Test Site Active P
§ . . abicot Gecup - L Associate this client with a Webroot site.
LabTech Test Client  LabTech Test Site Active Enabile| Auto Deploy R Jci - 2
Webroot Webroot Active Disabl Automate Scans * kGroup Enabled C D
| Open Client
Taner & Co Site Overridden  Active Enabl wr Enakled s __FJ
GSM Portal
Settings
Last data update: 20/07/2018 15:24:37 UTC
Help
Assign Webroot Site gy v Site Create Webroot Site
! e Site Name
Manual Site Keycode Global Transport Inc
Cancel Keycode Type
® Full ) 30 day trial
Seats “Required
Billing Cycle
Annually
Billing Date
Jan v 1 ~
Comments
Created by CW Automate
[ Include Global Policies
[ Include Global Overrides
Default Policy
High Security Policy v
Report Email Distribution List *Required
Create Cancel

Note: When a new site is created via the plugin, it may not show up in the site dropdown list immediately.
The refresh button may need to be clicked a couple times to reload the updated site list.
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Webroot Site > Use a non-GSM manually entered site key

The plugin allows users to enter a manual keycode for temporary use under exceptional circumstances,
such as when a Site is not part of the same Webroot GSM Console as the Unity API or during an upgrade
from an older version of the plugin. Users can then deploy endpoints to these sites via the plugin,
maintaining backward compatibility with older versions of the plugin.

NOTE: Manually entered keys cannot be tied to a GSM, advanced functionality using the Unity API will not
be possible with manually entered keys weather they are part of a GSM or not and all manually entered keys
will be shown as non-GSM within the computers tab.

To use a manually entered site key

Click on Clients tab

Right click on a specific Client

Select Webroot site

Select Assign Webroot site

Click within Manual Site Keycode and enter Manual Keycode

Click Save
@ Webroot SecureAnywhere with Unity - m} X
WEBROOT Clients ShowAll v Configure v Refresh
@webroot.com
R Seard]
Overview
Clients Drag a column header here to group by that column
BT | Client | Webroot Site | Webroot Site Status | Auto Deploy | Warkstation Group | Server Group | Automate Scans | Site Keycode -
. Global Transport Inc N/A /A Enabled /A /A Enabled /A
Locations
Test Test Site  Active Enabled Default Group Default Group Enabled 3 6
LabTech Test Client  LabTech Test Site  Active Enabled Default Group Default Group Enabled 3 2
Webroot ‘Webroot Active Disabled Default Galip Default Group Enabled C D
’ [ webroot site v|[ [ Assign webroot site Enabled
[n o
Webroot Group 3
EERIEoral L —| Associate this client with a Webroot site.
Aute Deploy 3
Settings Ao .
Last data update: 30/07/2 Liomate Scans
Help Open Client
(@ Webroot SecureAnywhere with Unity - O X

Assign Webroot Site Mew Site

[/

|Manual Site Keycode | S 2 I

Save Cancel

Once a manual key is assigned, the Webroot Site will show as Site Overridden.
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Webroot Site > Remove Webroot Site

To disassociate a Client from the Webroot Site, follow the process below.

Click on Clients tab

Right click on a specific Client

Select Webroot site

Select Remove

Site will be removed immediately from the plugin

@ Webroat SecureAnywhere with Unity - m} X
WEBROOT Clients ShowAll v Configure v Refrash
Bwebrootcom

Overview | =

Clients Drag a column header here to group by that column

Computers ‘Cliant ‘Webroct Site |Webroot Site Status | Auto Deploy ‘ ‘Workstation Group | Server Group |Auhomate Scans | Site Keycode -

= Global Transport Inc - N/A N/A Enabled N/A N/A Enabled N/A

Locations

Test Test Site Active Enabled Default Group Default Group Enabled 3 6

¥ LobTech Test Client  LabTech Test Site Active Webroot Site v Assign Webroot Site
Webroot Webroat Active Webroot Group » Remove Webroot Site C D
Auto Deploy &
Taner & Co Site Overridden  Active ‘ Remove the associated Webroot site from this client. 2
Automate Scans 3
GSM Portal Open Client
Settings

Last data update: 30/07/2018 11:46:00 UTC

Help

NOTE: The Site Removal action does NOT deactivate the site in the GSM and if needed the same site or
another site can be associated to a Client again.
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Webroot group — Auto Deploy to Group Policy

To assign different Webroot policies to Servers and/or Workstations in addition to the Default Webroot Site

Policy, specific Webroot Groups can be created in the Webroot Console on a per site basis and those groups
can be assigned within the plugin.

Follow the following process to automatically assign Server and Workstation policies when new computers are
added via the ConnectWise Automate plugin. Note: Existing computers that have registered with the Webroot

Console will NOT pick up the group policy, and they will need to have their policy manually changed either in the
plugin or in the Webroot Console.

Step 1 - Create either a new Global Server Policy in the GSM or use the existing Default Server Policy. In the
example below, we have created a new Global Server Policy called CWA Server Policy within the GSM.

SecureAnywhere

Dashboard Sites Admins Groups

QOverrides Alerts Reports Settings

Endpoint DNS
Add  [] Copy (%) Delete

Policies CWA Server Policy

Recommended Defaults

Name
Recommended DNS Enabled

CWA Server Policy

Recommended Server Defaulis
Silent Audit Description

Unmanaged Server policy for CWA Plugin Managed endpoints

A Cwa

er Policy
Policy Section

Step 2 - Create a Server Group in the Site Console and assign a server policy to it, e.g. CWA Server Policy

A 1
] ~
SecureAnywhere
'l =
Home Admins ~ Downloads
Status || Policies || GroupManagement || Reports || Overrides || Alerts || Settings || Logs || Resources
Groups Views Search Endpoints in Servers
eate P_I Actions ~ Hestname Palicy Status Last Seen
Group Name Mo.
All Endpoints 2 Edit Group
Default Grou| 1
" Group Name: Servers [22]
RemoteWorkers 1
— Description: Group specifically for servers 2=]
| Servers 0 1
Workstations 0 Policy: CWA Server Policy >
Save Cancel
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Step 3 — Assign the new Server Group created in the Webroot Console to the Plugin Server Group.

Click on Clients tab

Right click on a specific Client
Select Webroot Group
Select Assign

@ Webroot SecureAnywhere with Unity - O X
WEBRDOOT  Clients showat~ | [ Contguie v [ Retresn
@webrootcom
[ Sa

Overview
Clients Drag s column header here to group by that column
Computers | Chient | Webroot Site | Webroot Site Status | Auto Deploy | Workstation Group | Server Group | Automate Scans | Site Keycode -
Locations Global Transport inc  N/A N/A Enabled N/A N/A Enabled N/A

Test TestSite  Active Enabled Default Group Default Group Enabled 3 6

g Auto Re
Toner & Co Site Overridd Depky { Associate this client with @ Group for ions and Servers. }.2
Automate Scans
GSM Portal Open Client
Settings
Last data update: 30/07/2018 12:49:25 UTC
Help

Click on Server Group drop down menu
Select the newly created group (e.g. Servers)

@ Webroot Securefinywhere with Unity - m} X

Assign Webroot Group
Workstation Group
Workstations

Server Group

Default Group

Default Group

RemoteWorkers
Servers

Workstations

Any new Servers will now pick up the CWA Server Policy automatically when Webroot Clients are deployed
automatically.

Workstation policies can be assigned in a similar manner or the Workstation policy can be assigned to the
Default Site Policy.
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Auto Deploy

The Automate plugin is designed to automatically install Webroot endpoint security software whenever an
Automate client is installed. Auto deploy is Disabled by default at the Location level. Enabling Auto deploy
at Location level will turn on auto deploy for ALL endpoint in that Location. If you wish to restrict the deployment
of Webroot security software the specific endpoints, then this must be done at the Computer level by Disabling
auto deploy to specific endpoints such as Servers, BEFORE enabling Auto deploy at the Location level.

Auto deploy can be enabled or disabled at three different levels:
Client — Enabled by default

Location — Disabled by default

Computer — Enabled by default

The above arrangement provides complete flexibility in Enabling/Disabling Auto Deploy at any level depending
on specific requirements.

NOTE: Auto deploy will ONLY work if ALL levels are set to Enable.

To Enable or Disable Auto Deploy follow the steps below:

Click on Clients tab

Right click on a specific Client or highlight a number of Clients
Select Auto Deploy

Select Enable or Disable

@ Webroot Securefinywhere with Unity - m} X
WEBROOT Clients ShowAll v | | Configure » | Refresh
@webroot.com

Overview

Clients

Computers Client Webroot Site ‘Webroot Site Status | Auto Deploy | Workstation Group | Server Group | Automate Scans | Site Keycode

. Global Transport Inc - N/A N/A Enabled N/A MN/A Enabled N/A

Locations
Webroot Site »
Webroot Group 3
Auto Deploy 4 | Enable
Automate Scans 4 Disapble

Taner 8 Ca Site Overridden  Active Open Client l 1 Enables aute deployment for this client. I‘—CTCZ-BEEB-BBEz
GSM Portal
Settings
Last data update: 30/07/2018 13:51:14 UTC
Help

With the above example we have selected 3 Clients and Auto Deploy has been Enabled.

Note: If Auto Deploy is disabled at Location or at Computer level, Auto Deploy will not work by just
Enabling at Client level.
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You can run Webroot security scans directly within the plugin. If you want the ability to scan any Webroot
endpoint from the plugin, then Automate scans must be Enabled.

Note: Automate scans are totally independent from Webroot Policy or Webroot Console initiated scans.

Automate scans can be Enabled or Disabled at two different levels:

Client — Enabled by default
Computer — Enabled by default

To Enable or Disable ConnectWise Automate plugin initiated scans follow the steps below:

Click on Clients tab

Right click on a specific Client or highlight a number of Clients
Select Automate Scans
Select Enable or Disable

WEBROOT
@webroot.com
Overview
Clients
Computers

Locations

GSM Portal
Settings

Help

Q Webroot SecureAnywhere with Unity

Clients

Show All « Configure ~

[m] X

Refresh

Client Webroot Site

Webroot Site Status | Auto Deploy | Workstation Group | Server Group

Automate Scans | Site Keycode

Global Transport Inc M/A

LabTech Test Client  LabTech Te

Webroot Webroot

Taner & Co Site Qverri

M/

N/A Enabled N/A NAA
Webroot Site r

Webroot Group b ed Woarkstations

Auto Deploy b bled Default

Automate Scans r | Enable

Open Client

| Enables scans for this client.

ervers

Default Group

Enabled N/A
Enabled 3
Enabled C
Enabled 5

Last data update: 13/08/2018 12:24:24 UTC

e Enable — This will Enable scans from any of the trigger scan ConnectWise Automate scripts or plugin based
Webroot agent commands.

e Disable — This will Disable scans from any of the trigger scan ConnectWise Automate scripts or plugin
based Webroot agent commands.

Note: If scans are Disabled on Computer level, it will override the Client level being Enabled or vice versa.
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Computers tab

The computers tab displays all selected computers that have a ConnectWise Automate Client installed and
allows you to see a range of Webroot status information. Additionally, it allows the user to initiate a range of
actions and configurations, as seen below:

e Webroot agent commands

e Webroot agent policy setting
e Auto deploy

e Automate scans

e Open computer

Send Agent Command

To send an agent command

Click on Computer tab

Right click on a specific Computer or highlight a number of Computers
Select Send Agent Command

Select one of four commands e.g. Poll Management Console

@ Webroot SecureAnywhere with Unity

WEBROOT Computers ShowAll v | | Actions v | | Configure v Refresh

@webrootcom

Overview

Clients D) e :
R GSM | Intollatiogdifhgent Attention _ | Realtime Remediation | Active | Policy Endipoint

Computers

P St Compute <3 R Version e Se e e e e Keycode
Locations e

Send AgentCommand || Poll Console
s0ft Window o
i

Test NGWINT- Webroot policy 3 Run Deep Scan A N e Mo NA 3 6

Webroot FAKE-SERV-1 o Deply, ' Run Scan vith Cleanup INJA N/A No No N/A N/A

Automate Scans , Run Customer Support Diagnostics

N
X

i Enabled non-GSM Installed 902031 N/A o Yes Mo N/A N/A
Ve

F F z =z
z z z z
5 & & &

Tener & Co HAB-CORSAR Open Computer

GSM Portal
N/A N/A

Tener & Co TANERI-PC rosoft Windows 8.1 Pro x64 Enabled  Enabled non-GSM Installed 002031 N/A HNo

Settings
Last data update: 13/08/2018 13:07:33 UTC

Help

¢ Poll Management Console — This will send a direct Automate command to set the registry key
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\WRData\Actions:UpdateNow value to 1.

e Run Deep Scan — This queues the Webroot 3.x - Trigger Deep Scan script to run immediately.
Note: Automate scans must be Enabled at both Client and Computer level for this action to work.

Run Scan with Cleanup — This queues the Webroot 3.x - Trigger Scan with Cleanup script to run
immediately.

Note: Automate scans must be Enabled at both Client and Computer level for this action to work.

e Run Customer Support Diaghostics — This will prompt for an e-mail address, auto filling with the logged in
user's saved e-mail address, then queue the Webroot 3.x - Customer Support Diagnostics script to run
immediately.
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Webroot Policy

You can set or change a Webroot policy permanently or temporarily from the ConnectWise Automate plugin, on
one or more endpoints at the same time. The policy will be applied to the computer aimost immediately.

To set a new policy

Click on Computer tab

Right click on a specific Computer or highlight a number of Computers
Select Webroot Policy

Select Assign Policy

Select the policy Poll Management Console

@ Webroot SecureAnywhere with Unity - u] X
WEBROOT Computers ShowAll ¥ Actions v | Configure v Refrash
@webrootcom
Overview
Clients. Drag a column header here to gro at colum _
. ~ GSM Installation | Agent Atteg | Realtime | | Remediation | Active | Policy Endpoint
Computers Ciient Computer os Auto Deploy | Automate Scans ‘ o | Rl Last Seen Al ~ | Beoltine | infected | Jemiediation | Actve | POy e
Locations ) -
Send Agent Command » f
Test NGWINT. Microsoft Windows 7 Ultimate x64 Eabled  Enabled  |[ wenroot policy v [ assign policy No Mo No No  NA 3 6 |
Webroot FAKE-SERV-1 Microsoft Windows Server 2008 R2 Datacenter x64 Enabled  Enabled Auto Deploy » [nva No Ne Moo No No  NA A
Automate Scans >
Taner & Co HAB-CORSAIR Microsoft Windows 10 Pro x64 Enabled Enabled N/A No Yes Mo Yes No N/A N/A
e Open Computer
M Portal ]
Taner & Co TANER1-PC Microsoft Windows 8.1 Pro x64 Enabled Enabled non-G5M  Installed 902031 N/A No Yes No Yes No N/A N/A
Settings hd
Last data update: 13/08/2018 13:07:33 UTC
Help

Click the drop down menu
Click on the policy to be assigned e.g. No remediation policy

Assign Webroot Policies

Select Computer Policy

Mo remediation policy (Global)
Recommended Defaults (Default)
Recommended DNS Enabled (Default)
Recommended Server Defaults (Default)
Silent Audit (Default)
Unmanaged (Default)
CWA Server Policy (Global)
High Security Policy (Global)

| Mo remediation policy (Global)
Plugin Test Policy (Global)
Workstation (Global)
Local Test Policy (Site)

NOTE: There are different policy types such as Local, Default & Global. If multiple Computers are selected, only
the policies that are common across ALL computers will be shown.

If you wish to set a policy temporarily, then
Check the box Make this policy assignment temporary

Assign Webroot Policies
Select Computer Policy

Mo tion policy v

[] Make this policy assignment temporary.

Policy will reset to
No remediation policy in 4 hours

Save Cancel

The policy assignment will go back to the original setting indicated in red within 4 hours.
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Auto Deploy

The Automate plugin is designed to automatically install Webroot endpoint security software whenever an
Automate client is installed. Auto deploy is Enabled by default at the Computer level. Enabling Auto deploy at
Location level will turn on auto deploy for ALL endpoints in that Location. If you wish to restrict the deployment
of Webroot security software the specific endpoints, then this must be done at the Computer level by Disabling
auto deploy to specific endpoints such as Servers, BEFORE enabling Auto deploy at the Location level.

Auto deploy can be enabled or disabled at three different levels:
Client — Enabled by default

Location — Disabled by default

Computer — Enabled by default

The above arrangement provides complete flexibility in Enabling/Disabling Auto Deploy at any level depending
on specific requirements.

NOTE: Auto deploy will ONLY work if ALL levels are set to Enable.

To Enable or Disable Auto Deploy follow the steps below:

Click on Computers tab

Right click on a specific Computer or highlight a number of Computers
Select Auto Deploy

Select Enable or Disable

@ Webroot SecureAnywhere with Unity - o X

WEBROOT Computers Show All ¥ Actions v | | Configure v Refresh

@webroot.com

Overview

Clients

GSM |installation [Agent [ o Attention |Realtime ||| Remediation | Active | Poicy Endpoint

Computers =3 ot ) TS et S Pt e Ve Required | Shield Enabled | Threats |Name Tt

Locations

Send Agent Command v
Webroot SERV-1 Microsoft Windows Server 2008 R2 Datacenter x64 Enabled Webroot policy > Bled NA N No No Mo No No  N/A N/A
Auto Deploy > Disable
Taner & Co TANER1-PC Microsoft Windows 8.1 Pro x64 Enabled No Yes Mo Yes No  MN/A N/A
GSM Portal Automate Scans » Enable

Test NGWINT icrosaft Windows 7 Ultimate x64 Enabled Open Computer Bled NA  N/A No No Mo No No N/ 3

settings Enables auto deployment on this computer.
Last data update: 20/08/2018 09:57:03 UTC uto deployr i puter. |

Help

b

E

o Disable — This will exclude the selected computer/s from automatic installation of the Webroot software.

e Enable — This will enable automatic installation of the Webroot software on the selected computer/s.
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You can run Webroot security scans directly within the plugin. If you want the ability to scan any Webroot
endpoint from the plugin, then Automate scans must be Enabled.

Note: Automate scans are totally independent from Webroot Policy or Webroot Console initiated scans.

Automate scans can be Enabled or Disabled at two different levels:

Client — Enabled by default

Computer — Enabled by default

To Enable or Disable ConnectWise Automate plugin initiated scans follow the steps below:

Click on Computer tab
Right click on a specific Computer or highlight a number of Computers
Select Automate Scans

Select Enable or Disable

(@ Webroot SecureAnywhere with Unity

WEBROOT
@webroctcom
Overview
Clients
Computers

Locations

GSM Portal

Settings

Help

Computers

Show All ¥

Actions v | | Configure v

o x

Refresn

Client Computer

os

Auto Deploy | Automate Scans

GsM Installation | Agent.
Statws | Status Version

Last Seen

Atte.. _|Realtime
Req Tren e

Enabled

Remediation | Active | Policy
Threats | Name

Endpoint
Keycode

Test WINT
Webroot FAKE-SERV-1

Taner & Co TANER1-PC

Microsoft Windows

Microseft Windews Server 2008 R2 Datacenter x64 Disabled

Microsoft Windows

7 Ultimate x64

8.1 Prox64

Enabled

Enabled

Enabled

Enabled

Enabled

Send Agent Command »
Webroot policy » b
Auto Deploy »

Automate Scans »

Disable

Open Computer

Enable

Yes

No, No Mo No

o No Mo No

No Yes Mo Yes

N/A

N/A

N/A

E

N/A

N/A

i) »

Last data update: 20/08/2018 09:32:26 UTC

[ includes scans for this computer

e Enable — This will Enable scans from any of the trigger scan ConnectWise Automate scripts or plugin based
Webroot agent commands.
e Disable — This will Disable scans from any of the trigger scan ConnectWise Automate scripts or plugin
based Webroot agent commands.

Note: If scans are Disabled on Computer level, it will override the Client level being Enabled or vice versa.
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Locations

The locations dashboard allows you to set Auto Deployment options, as well as directly open the location from
the dashboard.

Auto Deploy

The Automate plugin is designed to automatically install Webroot endpoint security software whenever an
Automate client is installed. Auto deploy is Enabled by default at Computer level. Enabling Auto deploy at
Location level will turn on auto deploy for ALL endpoints in that Location. If you wish to restrict the deployment
of Webroot security software the specific endpoints, then this must be done at the Computer level by Disabling
auto deploy to specific endpoints such as Servers, BEFORE enabling Auto deploy at the Location level.

Auto deploy can be enabled or disabled at three different levels:
Client — Enabled by default

Location — Disabled by default

Computer — Enabled by default

The above arrangement provides complete flexibility in Enabling/Disabling Auto Deploy at any level depending
on specific requirements.

NOTE: Auto deploy will ONLY work if ALL levels are set to Enable.

To Enable or Disable Auto Deploy follow the steps below:

Click on Location tab

Right click on a specific Location or highlight a number of Locations
Select Auto Deploy

Select Enable or Disable

@ Webroot SecureAnywhere with Unity - O X
WEBROOT Locations Configure v Refresh
@webroot.com
Overview
Clients
Computers Client Location Auto Deploy
a

Locations Auto Deploy ’ Disable

Webroot Main Disabled Open Location Enable 3

LabTech Test Client  Virtual Machines Disabled Enables auto deployment
GSM Portal

Taner & Co London Disabled
Settings

Last data update: 26/08/2018 10:03:17 UTC

Help

e Disable — This will exclude the selected Location/s from automatic installation of the Webroot software.

e Enable — This will enable automatic installation of the Webroot software on the selected Location/s.
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GSM Portal

This feature launches the default system browser to the URL https://my.webrootanywhere.com/
to allow additional admin tasks from the GSM console.

Webroot SecureAnywhere with Unity -
W] y s o x
WEBROOT Overview All clients ¥ Refresh
@webroot.
webroot.com - _ o «
Overview m My Account | Webroot X
Clients &« (& | & Secure | httpsy//my.webrootanywhere.com/defaultaspx Q ¥ ‘ ‘ (/]
Computers I Apps P Search »
Locations
WEBRDOT

SecureAnywhere

Login

Email or Phone @
@webroot.com -]

Password Forgotten Password?

Get started

nsumer Release Notes B elease Note Commur
English
GSM Portal
2018 Webroot Inc.  Privacy Statament  Website Terms of Service  License Agreement
Settings
Help
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Settings

The settings tab allows you to enter the Webroot Unity API credentials as well as set a number of additional
alerts and actions.

API Authentication
Allows the ability to enter and save Webroot Unity API credentials. Please click here for a video explanation.

Webroot Agent

The unique identifier option allows you to enable/disable the "-clone" switch during installation. When enabled,
the computer name in the GSM console will be suffixed with a random set of characters to make it unique.

NOTE: This feature is OFF by default and should only be used under exceptional circumstances, please seek
advice from Webroot before use.

Alerts and Pop-ups
Alerts and Pop-ups will allow you to enable/disable alerts from monitors.

(@ Webroot Secureinywhere with Unity — | *

WEBROOT Settings

@webroot.com API Authentication Webroot Agent
Overview Good Connection Logout [_] Use the unique identifier option during installation
Clients
Computers Alerts and Pop-ups

Locations (/] Enable additional alerts when computers are in an "Attention Required” state

[+/] Enable reboot pop-ups when computers are in an "Attention Required” state
[/] Enable additional alerts when computers stay infected for longerthan |12 ¥ | haurs
(/] Enable alerts when endpoint is stale for longerthan ' 30~ | days

(/] Enable expired license alerts
GSM Portal

Settings Save

Help

e Enable additional alerts when computers are in an “Attention Required” state
Tied to the “Webroot 3 — Attention Required” monitor that will create an actionable ticket for techs.

To keep the malware reporting noise down to a minimum, we have created a new “Attention Required” alert
specifically designed for MSP environments. This alert is raised if an endpoint remains infected after 2
contiguous 12-hour checks from the point of infection detection. If the endpoint is switched off during one of
the 12-hour checks or in the process of performing a scan at the end of a 12 check, the counter will be reset
for another 12 hours. In practice, the “Attention Required” alert will be true if the endpoint remains infected
after about 36 hours. This ensures the endpoint has gone through at least 1 reboot/scan cycle before raising
the Attention Required flag.

Important Note: The “Attention Required” flag in the plugin is distinctly different than the “Needs Attention or
Devices Requiring Attention” state in the Webroot Console, which is set as soon as an infection is detected.
Each indicator works independently.
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e Enable reboot pop-ups when computers are in an “Attention Required” state
Tied to the “Webroot 3 — Attention Required” monitor that will create an actionable ticket for techs.

Sometimes, for the Webroot agent to fully remediate a persistent threat, or to declare an endpoint free of
malware, one or more reboot cycles may be needed. If users do not shutdown their PCs overnight then it
could remain infected. Enabling the “reboot pop-up alert” after the “Attention Required” flag is set will ensure
a pop-up alert is sent to the end users’ device at midday, informing the user to reboot.

e Enable additional alerts when computers stay infected for longer than x hours
Tied to the “Webroot 3 — Active Infection” monitor that will create an actionable ticket for techs.

When a Webroot agent stays infected for longer than the amount of hours defined (2, 8, 12, 24) an additional
alert will be triggered via the “Webroot - Active Infection” Internal Monitor. This alert is useful for customers
who need to be informed of persistent infections as quickly as possible.

o Enable alerts when endpoint is stale for longer than x days
Tied to the “Webroot 3 — Stale Agents” monitor that will create an actionable ticket for techs.

If a Webroot agent fails to successfully check-in to the Webroot cloud for longer than the days defined (7, 15,
30, 60, 90) an alert will be triggered via the “Webroot - Stale Agents” Internal Monitor.

e Enable expired license alerts
Tied to the “Webroot 3 — License Expired” monitor that will create an actionable ticket for techs.

When a Webroot agent’s license expires it will trigger an alert via the “Webroot - License Expired” Internal
Monitor. Under normal circumstances all licenses are tied to the GSM Parent Key and should not expire,
however, if you notice this alert, then it could indicate an issue with the endpoint.
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Help
e Customer Support — The Get Customer Support button opens the systems default bowser to:

http://www.webrootanywhere.com/howcanwehelpbusiness.asp

e Webroot Community — The Go to Webroot Community button opens the systems default browser to:

https://community.webroot.com/t5/Business/ct-p/ent0

e Webroot Manual — The Go to Webroot Manual button opens the PDF manual page in the default reader:

https://download.webroot.com/RMM/Webroot _Integration for ConnectWise Automate User Guide v3-0.pdf

([ Webroot SecureAnywhere with Unity - O *

WEBROOT  Help

@webroot.com Customer Support
Overview Webroot customer support is always available if you have a question.
Clients & | Get Customer Support
Computers
Locations

Webroot Community

Discuss security topics with peers, talk to experts, and share your ideas.

@  Go to Webroot community

Webroot Manual

Open documentation pertaining to Webroot SecureAnywhere,

@  Goto Webroot manual

GSM Portal
Settings

Help
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Computer Plugin Page

The computer plugin page provides additional details about the endpoint state such as shield status, scan
statistics and agent status. Endpoint specific settings such as auto deploy, automate scans and endpoint policy

can also be set.

To access the Computer plugin page, open a specific computer either within the Webroot plugin, for example, by
double clicking on a computer and then click on the plugin icon and select Webroot SecureAnywhere with Unity

LabTech Test Client/Virtual Machines/NGWIN7-LABTECH (2) Phone: - (Primary) / - o bs
[0 ittt | o pleOL
Webroot
SecureAnywhere with Remote Access
Unity
Standards & Health Ignite
- sazs AN A B o o
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WEBROOT

The computer plugin page is broken into two parts, System and Threat History.

System

This page contains details about the Webroot agent, gives the ability to Enable Auto Deploy and Automate
Scans, set a permanent or temporary Webroot Policy, as well as issue all Webroot agent commands available in
the plugin via the Action drop down menu.

LabTech Test Client/Virtual Machines/NGWIN7-LABTECH (2) Phone: -- (Primary) - O X
LabTech Test../Virtual Machi. o g 0 o OO
Idle e 01:02:14
¥
NGWINT7-LABTECH e aa @S
Webroot SecureAnywhere with Unity
WEBRD(? System Acions v | [ Reefresh
System Protection
Scan Statistics Agent
Uz A + Realtime Shield © ID Shield
Last Scan 19/07/2018 12:06:11 UTC Engine Version 902031
© Offline Shield + Phishing Shield
Last Scan Duration 39 Signature Update 19/07/2018 12:0524 UTC
+ Fiootkit Shield v USE Shicld
Files Scanned 21610 Expiration Date 04/06/2020 06:00.00 UTC
© Web Threat Shield
Scheduled Scan Enabled Enabled Days Remaining 686
Scheduled Scan Time 04:00 Silent Install Disabled
Active Threat Count e GSM Status GsMm
Total Scans 76
Total Threats Remaved &5
Settings Commands
Auto Deploy No commands running.
Automate Scans
Assigned Policy: No remediation policy  Assign Policy
Last data update: 28/08/2018 10:52:53 UTC
Ignite Remote Ac..  Standards...
Begin  ILANIPAON=NS ®AY WD o e
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Threat History

This contains all threat information and details on that Webroot agent.

LabTech Test Client/Virtual Machines/NGWIN7-LABTECH (2) Phone: -- (Primary) - a x
WORKGROUP! ©
LabTech Test_/Virtual Machi dle Time: 01:02:14 ?; gg @ D m
NGWIN7-LABTECH T

Webroot SecureAnywhere with Unity

WEBROOT _ Threat History Refresn
System
Threat History
Drag a column header hers to group by that column
| Filsname | Pathname
UTC Adware ZQuest clusersUcofemoz7 77444 dil
01/06/2017 10:32:00 UTC W32 Trojan.Backdoor-Ciadoor clusers\ emsnv1.dll
01/06/2017 10:32:00 UTC W32 Trojan.Trojan-Downloader-Peregar clusers) \cndr32a.dll
01/06/2017 10:32:00 UTC W32 Trojan.Trojan Gen X cusers\ \clipuser32.dll
01/06/2017 10:33:00 UTC  Adware ZQuest clusers\ wofemoz777444 dll
01/06/2017 10:33:00 UTC W32 Trojan.Backdoor-Ciadoor clusers\ iemsnv1.dll
01/06/2017 10:23:00 UTC W32 Trojan.Trojan-Downloader-Peregar  ciluserst| wendr32a.dil
01/06/2017 10:33:00 UTC W32 Trojan.Trojan Gen X cusers\] wclipuser32 dil
D1/06/2018 09:06:00 UTC W32 Trojan Trojan Gen X cusers d\1c8c6164\spy itelcli 32.dll
01/06/2018 09:07:00 UTC  Adware. ZQuest clusersy d\1cOcB164\spy it fe 77444 dIl
01/06/2018 09:07:00 UTC W32 Trojan.Trojan-Downloader-Peregar  clusersh di1cOc6164\spy it dr32a.dll
01/06/2018 08:07:00 UTC W32 Trojan.Trojan-Downloader-Peregar  clusersis cndr32a dil
01/06/2018 09-:07-00 UTC  Adware ZQuest cusersir cofemoz777444 dil
01/06/2018 09:07:00 UTC W32 Trojan.Trojan.Gen.X. clusers\y clipuser32.dil v

Ignite Remote Ac_  Standards

EEl-rsegs EOARNEZAD % % -
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Monitors
1. With the plugin installed, from the Main Toolbar of the Automate Control Center, click the Monitors button.
k3
& Main  View isplay  Status:IN  Active Timeslips |
22 refresn |l oashooard I wonicors %Alerts&lnfo
{2} Webroot - https:/, hostedrmm.com - U

<+ New
Dataviews
Monitors

Patch Manager

Schedules

Scripts

Searches

Templates

This will display all the Automate monitors.
Click the Internal Monitors tab.

3. Filter on webroot.
You should see six monitors:

Webroot 3 - Stale Agents
Webroot 3 - Reboot Needed
Webroot 3 - Not Installed
Webroot 3 - License Expired
Webroot 3 - Attention Required
Webroot 3 - Active Infection

M A Monitors X

jﬂmt:.ﬁgmt Monitors lR mate Metwork Monitors lSwtem Monitors llucaums_ Internal Monitors _
No Filter = / Search - | Clear | 2 ||} Options ~

- - -

Monitor Status Monitor Duration

e Websoot 3 - Stale Agents Every Hour
e Websoot 3 - Reboot Meeded Every Hour
e Webrmnot 3 - Not Installad Every 5 Minutes
e Webmot 3 - License Expired Every Hour
e Webroot 3 - Attention Fequired Every Hour
e Webroot 3 - Active Infection Every Hour

Page 45 | © 2019 Webroot Inc. All rights reserved. | Proprietary and Confidential Information May 29, 2019



WEBROOT Integration for ConnectWise Automate User Guide

CW Automate Group

The ConnectWise Automate group created is Webroot SecureAnywhere and will contain all computers from the
Automate system that have Webroot installed on them. It's a sub-group of Antivirus Management group.

Scripts

The CWA scripts created are:

e Webroot 3.x - Customer Support Diagnostics
e Webroot 3.x - Install SecureAnywhere

e Webroot 3.x - Reboot Needed

e Webroot 3.x - Trigger Deep Scan

e Webroot 3.x - Trigger Full System Scan

e Webroot 3.x - Trigger Scan With Cleanup

e Webroot 3.x - Uninstall SecureAnywhere

—-|gl Soipts
i 'Hmf—j Actons

_1 Antivirus

) Webroot SecureAnywhere

_| Webroot 3.0 - Customer Support Diagnostics (5955)
[ Webroot 3.0 - Install SecureAnywhere (5949)
Webroot 3.0 - Reboot Needed (5954)
Webroot 3.0 - Trigger Deep Scan (5951)
Webroot 3.0 - Trigger Full System Scan (5952)
.| Webroot 3.0 - Trigger Scan With Cleanup (5953)
! Webroot 3.0 - Uninstall SecureAnywhere (5950)

s’rﬂ_n‘;_,ﬂt.,ﬁiir

i

(I
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Database Tables

If you have direct access to your database, you can verify the needed table were created.
The following database tables should have been created:

e plugin_webroot3_api

e plugin_webroot3_clients

e plugin_webroot3_computers

e plugin_webroot3_locations

e plugin_webroot3_settings

e plugin_webroot3_threathistory

Each database table has a default settings row. All checkboxes are saved as 0 or 1 in the database (0 =
unchecked, 1 = checked). The default settings row data should match the settings page.

Fiter tables in labtech
[webroot

B Admin@localhost
# EJ information_schema
= gl labtech
= |y Tables

[+ =2 plugin_webroot3_api

[+ plugin_webroot3_clients
[+ plugin_webroot3_computers
[+ plugin_webroot3_locations
[+ plugin_webroot3_settings
# T plugin_webroot3_threathistory
& Views
# ), Stored Procs

i () D

| |*

Page 47 | © 2019 Webroot Inc. All rights reserved. | Proprietary and Confidential Information May 29, 2019



WEBROOT Integration for ConnectWise Automate User Guide

Adding/Updating Plugin via Plugin Manager
To add or update a plugin via the LabTech Plugin Manager follow these steps in the LabTech Control Center.
To add or update the plugin:

1. Loginto the LabTech Control Center.
2. From the Help menu, select Plugin Manager.

Links Tools | Help
k Info @ Ti Online Manual
Getting Started Wizard

Plugin Manager

Server Status

Show Tips
About
1!
42+ Webroot - https:// hostedrmm.com - Ut
+ New

Configuration
General

Solutions

Plugin Manager

Solution Center

Users and Contacts

R P Ve » X iy
& Deane 2 N O A +
M resiet Ao L} it - . Yo At Desrwee oy . natad e e L | Tobod Popm .
O g 4 o e b T e T LD | P h -ty Tt g .
S
O LS PR —rtea A ~ -
O , R — - v
8 omng - wALw 1w Coh s ets Penin 0 e ooy g - -
| P
£ ertenan L1 « - . e e
Ty e e S STy e
cew--- - e -
--——-- - ———— —— -
- =
. » -
5 sovrtoverngr P S wi——— SewwCe
R —— S B SoerCoven bumy shgr sete e 7 Soanth
O s hrenn e 6 A eerost Pe Sewr tngre eye
I L T T ——— Tiwrve
S S . - T By e s et - rarege w ot wiy
5 "HCesdcen. 434 e wAGw Fe et he e e T e~
I
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e When adding a new plugin — If it has Remote agent functionality, you must select the Remote Agent
checkbox before clicking the Save and Close button.

Enter the required plugin informiation .
Name I -

Authaor ISuck Advisars, LLC

I

[+ Remote Agert

Fi&mme[ R —

Diescription

| Cancel || SaveandClose |

¢ When adding a new plugin — After the plugin is added and displays in the Plugin Manager, select the
plugin, then click the Enable icon.

i i Enable & Disable
o @

Mame We.,. =  Author Description
ScreenConnect Re...  3.1... ... |The ScreenConnect Remote plu
EE:-:rF-F-r.-‘.'_fq:nns--:T phigin Z1iees |Lab... | The ScreenConnect plugn allows

v l_T License Mana..  3.0.5.0 Lab.. |LabTech License Manager -

e When updating a plugin, you must select the desired plugin in the table.
4. Reload the Plugins. This will ensure the plugin has fully loaded on the server and remote systems.
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5. Select Advanced -> Reload Plugins -> Reload DBAgent Plugins, then select Update Remote Agent
Plugins, then select Reload Control Center Plugins.

The order in which the reloads happen should be as described.
When the Remote Agent and DBAgent are updated/reloaded it will restart the database agent, wait for
that to finish restarting before moving on to the next update/reload.
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Known issues

There are no know issues with this release.
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